
CSC – Finnish research, education, culture and public administration ICT knowledge center

Elmer/Ice – New Generation Ice Sheet
Model

Thomas Zwinger, Elmer/Ice beginner's course



2D GLACIER TOY MODEL

These sessions shall introduce into the basics of Elmer/Ice. It follows the
strategy of having a possibly simple flow-line setup, but containing all
elements the user needs in real world examples, such as reading in
DEM’s, applying temperature and accumulation distributions, etc.
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DIAGNOSTIC RUN

Starting from a given point-distribution (DEM) in 2D we show
how to:

• Create the mesh

• Set up runs on fixed geometry (diagnostic)

• Introduce sliding

• Manipulate (structured) mesh shape inside Elmer

• Use tables to  interpolate values

• Write a simple MATC function (interpreted functions)

• Post-process results

3



The diagnostic problem

§We start from a
distribution of
surface and
bedrock points
that have been
created driving a
prognostic run
into steady state
§ The distributions are given in the files:

steady_ELA400_bedrock.dat , steady_ELA400_surface.dat
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The diagnostic problem

• We will study a ~11 deg inclined glacier

• We will start with a flat mesh (produced with Gmsh) of unit-
height
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The diagnostic problem

• If you have not already saved the mesh from Gmsh, do the
following (find Gmsh instructions at end of slides):

$ gmsh -2 testglacier.geo

• Use ElmerGrid to convert the mesh:

> ElmerGrid 14 2 testglacier.msh\

–autoclean –order 0.1 1.0 0.01

Orders the numbering in x
y z –directions (highest
number fastest)

Needed to
clean up
geometry
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The diagnostic problem
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The diagnostic problem

• We will do a diagnostic simulation, i.e., we ignore the time
derivative in ANY equation
oStokes anyhow has no explicit time dependence

oThat also means, that the surface velocity distribution is a result of the
given geometry and cannot be prescribed (no accumulation)

• Open the Solver Input File (SIF)

$ emacs Stokes_diagnostic.sif &
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The diagnostic problem

This declares our mesh; capital/small letters matter

Steady State = diagnostic

The coordinate system (incl. Dimension)
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The diagnostic problem

Assigns the Equation/Material/Body Force/and Initial conditionto a
body

Well, as the name suggests: initial values for variables

The Equation for Body 1 (see above); declares set of Solvers
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On Bodies and Boundaries
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On Bodies and Boundaries

• Each Body has to have an
Equation and Material
assigned
Body Force,Initial
Conditionoptional

• Two bodies can have the same
Material/Equation/Body
Force/Initial Condition
section assigned

Body 1Body 2

Material 1

Body Force 1

Material 2

Equation 1
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! maps DEM's at the very beginning
! to originally rectangular mesh
! see Top and Bottom Surface in BC's
Solver 1

Exec Solver = ”Before Simulation"
Equation = "MapCoordinate"
Procedure = "StructuredMeshMapper" "StructuredMeshMapper"
Active Coordinate = Integer 2! the mesh-update is y-direction

! For time being this is currently externally allocated
Mesh Velocity Variable = String "Mesh Velocity 2"

! The 1st value is special as the mesh velocity could be unrelistically high
Mesh Velocity First Zero = Logical True

! The accuracy applied to vector-projections
Dot Product Tolerance = Real 0.01

End

The diagnostic problem

The primary criterion for order of execution is the Exec
Solver keyword, thereafter the numbering

This solver simply projects the shape given in the input files
before the run (see Exec Solver keyword) to the initially flat mesh;
See Top Surface and Bottom Surface keywords later
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The diagnostic problem
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Top Surface (at correlating boundary condition)

Bottom Surface (at correlating boundary condition)



The diagnostic problem

Solver 2
Equation = "HeightDepth"
Procedure = "StructuredProjectToPlane" "StructuredProjectToPlane"

Active Coordinate = Integer 2
Operator 1 = depth
Operator 2 = height

End

Computes flow depth and height based on
vertically aligned ("structured") mesh
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Linear System Solver keyword chooses type of
solution of the linearized problem

The diagnostic problem

You need that in Stokes and also in PDE’s with significant
amount of convection

Account for non-linearity of the rheology
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On iteration methods
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This is for scaling reasons (see next slide)

The diagnostic problem
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For the Stokes problem, one should give values for:
- the density:
- the gravity:
- the viscosity:

Elmer(/Ice) does not assume any choice of units. This is on you, BUT, units have to
be consistent amongst each other and with the mesh geometry units.
The order of magnitude in numbers do not change results, as matrix is pivoted

kg – m – s [SI] :  velocity in m/s and time-step in seconds

kg – m – a :  velocity in m/a and timesteps in years

MPa – m – a : velocity in m/a and Stress in MPa

(What we have in our SIF)

On the choice of units
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On the choice of units

To give you an example: for ISMIP tests A-D, the value for the
constants would be

- the density:
- the gravity:
- the fluidity:

USI kg - m - s  kg - m - a

g = 9.81 9.7692E+15 9.7692E+15

r = 910 910 9.1380E-19
A = 3.1689E-24 1.0126E-61 100

5.4037E+07 1.7029E+20 0.1710

MPa - m - a

m / s2 m / a2 m / a2

kg / m3 kg / m3 MPa m-2 a2

kg-3 m3 s5 kg-3 m3 a5 MPa-3 a-1

h = kg m-1 s-5/3 kg m-1 a-5/3 MPa a1/3
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We set our glacier to be at -3 C

The diagnostic problem

Now commented, needed later

Gravity, scaled to deliver results
in m/a and MPa
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The diagnostic problem

• Boundary conditions:
ousing array function for

reading surfaces

oReal [cubic]
expects two columned row:

x1 z1
x2 z2
…

oinclude just inserts
external file (length)

oRight values interpolated by
matching interval of left
values for input variable
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The diagnostic problem

• Now, run the case:

$ ElmerSolver Stokes_diagnostic.sif
oYou will see the convergence history displayed:

FlowSolve: -------------------------------------
FlowSolve:  NAVIER-STOKES ITERATION          23
FlowSolve: -------------------------------------
FlowSolve:
FlowSolve: Starting Assembly...
FlowSolve: Assembly done
FlowSolve: Dirichlet conditions done
ComputeChange: NS (ITER=23) (NRM,RELC): (  1.6112696
0.90361030E-03 ) :: navier-stokes
FlowSolve: iter:   23 Assembly: (s)    0.26    6.04
FlowSolve: iter:   23 Solve:    (s)    0.11    2.62
FlowSolve:  Result Norm     :    1.6112695610649261
FlowSolve:  Relative Change :    9.0361030224648782E-004

23



The diagnostic problem

• Post-processing using ParaView: $ paraview
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The diagnostic problem

• File →Open stokes_ela400_diagnostic0001.vtu
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The diagnostic problem

• Apply
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The diagnostic problem

• Change to velocity

Press to
activate
colour
bar
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The diagnostic problem

• Change colours

1.
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2.

3.
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Sliding

• Different sliding laws in Elmer

• Simplest: Linear Weertman
oThis is formulated for the traction     and velocity      in tangential plane

• In order to define properties in normal-tangential coordinates:
Normal-Tangential Velocity = True

• is the Slip Coefficient {2,3} (for the tangential
directions 2 and 3) (for 3D, in 2d only direction 2)

• Setting normal velocity to zero (no-penetration)

Velocity 1 = 0.0
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Sliding

• Now we introduce sliding
oWe deploy a sliding zone between z=300 and 400m
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Definition of slip Coefficient

Use normal-tangential
coordinate system



Sliding

Replace the FlowDepth Solver with this one. This solver simply
uses the vertically structured mesh to inquire the Depth/Height
without solving a PDE (much cheaper).
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Sliding

• Restart from previous run (improved initial guess)
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Load the last entry in file



Sliding

• Now, run the case:

$ ElmerSolver Stokes_diagnostic_slide.sif
oConverged much earlier:

FlowSolve: -------------------------------------
FlowSolve:  NAVIER-STOKES ITERATION          12
FlowSolve: -------------------------------------
FlowSolve:
FlowSolve: Starting Assembly...
FlowSolve: Assembly done
FlowSolve: Dirichlet conditions done
ComputeChange: NS (ITER=12) (NRM,RELC): (  3.4915753
0.34732117E-05 ) :: navier-stokes
FlowSolve: iter:   12 Assembly: (s)    0.32    3.53
FlowSolve: iter:   12 Solve:    (s)    0.12    1.38
FlowSolve:  Result Norm     :    3.4915753430899730
FlowSolve:  Relative Change :    3.4732116934487441E-006
ComputeChange: SS (ITER=1) (NRM,RELC): (  3.4915753
2.0000000     ) :: navier-stokes
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Sliding

• Load parallel to previous file

• File →Open stokes_ela400_diagnostic_slide0001.vtu
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Sliding

1. 2.
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Sliding
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Right click right
window

Link Camera…
Left click on left
window



Sliding
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Right click right
window

Left click on left
window

Scales velocity
and syncs
behaviour
between
windows



End of first session

What you should know by now:

• Basic diagnostic (= steady state with prescribed geometry) iso-thermal
simulation

• Linear system, Non-linear system solution

• Iterative/direct solver

• Read-in of simple DEM, manipulation of initial mesh (structured)

• Using tabulated value interpolation

• Writing interpreted MATC function

• Basic Paraview post-processing
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HEAT TRANSFER

Starting from the diagnostic setup of the previous session we:

• Compute the temperature for a given velocity field and
boundary conditions

• Introduce heat transfer

• Account for pressure-melting point

• Add Thermo-mechanical coupling (viscosity-temperature)
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Heat transfer

• Adding heat transfer to
Stokes_diagnostic_slide.sif:
oAdd ElmerIceSolvers TemperateIceSolver with

variable nameTemp (see next slide)

oSurface temperature distribution: linear from 273.15 K at z=0m to
263.15 K at z=1000m

oGeothermal heat flux of 200 mW m-2 at bedrock
oMake sure you restart from
Stokes_ELA400_diagnostic_slide.result

Temp = Variable Coordinate 2
Real

0.0   273.15
1000.0   263.15

End
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Heat transfer

Solver 5
Equation = String "Homologous Temperature Equation"
Procedure =  File "ElmerIceSolvers" "TemperateIceSolver"
Variable = String "Temp"
Variable DOFs = 1
Stabilize = True
Optimize Bandwidth = Logical True
Linear System Solver = "Iterative"
Linear System Direct Method = UMFPACK
Linear System Convergence Tolerance = 1.0E-06
Linear System Abort Not Converged = False
Linear System Preconditioning = "ILU1"
Linear System Residual Output = 0
Nonlinear System Convergence Tolerance = 1.0E-05
Nonlinear System Max Iterations = 100
Nonlinear System Relaxation Factor = Real 9.999E-01
Steady State Convergence Tolerance = 1.0E-04

End
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Heat transfer

• Material parameters in Material section

• Using defined MATC-functions for

oCapacity:
oConductivity:

Material 1
…
! Heat transfer stuff
Temp Heat Capacity = Variable Temp

Real MATC "capacity(tx)*(31556926.0)^(2.0)"

Temp Heat Conductivity = Variable Temp
Real MATC "conductivity(tx)*31556926.0*1.0E-06"

End
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Heat transfer

• Material parameters in Material section

• Using defined MATC-functions for

oCapacity:
oConductivity:

!! conductivity
$ function conductivity(T)  { _conductivity=9.828*exp(-5.7E-03*T)}
!! capacity
$ function capacity(T) { _capacity=146.3+(7.253*T)}
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Heat transfer

• Now, run the case:

$ ElmerSolver Stokes_diagnostic_temp.sif

• It goes pretty quick, as we only have one-way coupling and
hence don’t even execute the Stokes solver

Solver 3
Exec Solver = "Never" ! we have a solution from previous case
Equation = "Navier-Stokes"
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Heat transfer

• Due to high
geothermal
heatflux we have
areas above
pressure melting
point

• We have to account
for this
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Heat transfer

• Constrained heat transfer:
o Including following lines in Solver section  of
TemperateIceSolver

! the contact algorithm (aka Dirichlet algorithm)
!-----------------------------------------------------
Apply Dirichlet = Logical True
! those two variables are needed in order to store
! the relative or homologous temperature as well
! as the residual
!-------------------------------------------------
Exported Variable 1 = String "Temp Homologous"
Exported Variable 1 DOFs = 1
Exported Variable 2 = String "Temp Residual"
Exported Variable 2 DOFs = 1
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Heat transfer

• Constrained heat transfer:
oAlso introduce the upper limit for the temperature (a.k.a. pressure

melting point) in the Material section

Temp Upper Limit = Variable Depth
Real MATC "273.15 – clausclap * tx * 910.0 * 9.81"
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Heat transfer

• Now, run the case:

$ ElmerSolver \
Stokes_diagnostic_temp_constrained.sif

• Already from the norm (~ averaged nodal values) it comes
clear that values are in general now lower

TemperateIceSolver (temp): iter:    5 Assembly: (s)    1.36    6.77
TemperateIceSolver (temp): iter:    5 Solve:    (s)    0.00    0.01
TemperateIceSolver (temp):  Result Norm   :    271.78121462656480
TemperateIceSolver (temp):  Relative Change :
5.0215061382786350E-006
ComputeChange: SS (ITER=1) (NRM,RELC): (  271.78121      2.0000000
) :: homologous temperature equation
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Heat transfer

ConstrainedUnconstrained
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Heat transfer

• Thermo-mechanically coupled simulation:
oWe have to iterate between Stokes and HTEq.

oCoupling to viscosity in Material section

Steady State Max Iterations = 20

! the variable taken to evaluate the Arrhenius law
! in general this should be the temperature relative
! to pressure melting point. The suggestion below plugs
! in the correct value obtained with TemperateIceSolver
Temperature Field Variable = String "Temp Homologous"
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Newton Iterations

• We need Picard (=fixed-point) iterations instead of Newton
iterations at the beginning of each new non-linear iteration
loop

Solver 1

!  Exec Solver = "Never"

Equation = "Navier-Stokes“

…

Nonlinear System Reset Newton = Logical True

!Nonlinear System Relaxation Factor = 0.75

End

53



Heat transfer

Thermo-mechanically coupledUncoupled
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End of third session

What you should know on top of the previous session:

• Basic diagnostic (= steady state with prescribed geometry)
simulation including heat transfer equation (HTEq)

• Introduction of constraint (pressure-melting) into HTEq

• Thermo-mechanically coupled system
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PROGNOSTIC RUN

• Starting from a deglaciated situation we show

• How to move to a transient run, i.e., introduce the
• Free surface solution
• Including coupling to climate via prescribing an

accumulation/ablation function

• How to write a less simple MATC function

• How to write a (faster than MATC) Lua function
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The prognostic problem

• Glacier with ~11 deg constant inclination

• Standard accumulation/ablation function

• Or in terms of ELA (equilibrium line altitude):

• We know lapserate, , and              and have to define
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The Problem

• From x=[0 :2500], z=[0:500]

• Setting mesh with 10 vertical levels with 5m flow depth
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The Problem

• Flow problem  (Navier-Stokes) in ice

• Free-surface problem on free surface
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Time Stepping
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Free Surface Equation
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• Free surface equation is only
run on  - surprise! – the free
surface

• Which renders it a lower-
dimensional problem

• We need to declare a new(2nd )
body on this surface



Free Surface Equation
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Free Surface Equation

t=0: Zs = RefZs

t>0:
Top Surface = Zs
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Free Surface Equation

• Starting with same values for both variables
set to the bedrock shape of the diagnostic
example

• Using the latter to keep minimal height ( in
Material)
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Free Surface Equation

• And here comes the coupling to climate (as a general MATC
function)
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Free Surface Equation
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Passive elements

• We further switch the (Navier-)Stokes solution to passive in
regions with flow-depth below threshold

• This usually brings more stable ice-fronts (uncomment to see
difference)
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The Solution

• Starting with no-flow problem, i.e., only surface mass balance,
simply by setting Convection = “none” and (saves time) not
executing Navier-Stokes, compare to run with coupled flow

• $ ElmerSolver Stokes_prognostic.sif

69



LUA – the faster alternative to MATC

• Similar syntax than MATC, but  much faster

!---LUA BEGIN
! -- this is our accumulation rate
! function accum(X,Z)
!  if (X > 2500) then
!    return 0.0
!  else
!    return 11.0*Z/2750 - 400.0*11.0/2750.0
!  end
!end
!---LUA END
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End of fourth session

What you should know on top of previous sessions:

• Basic prognostic (= time dependent with prescribed surface
mass balance) simulation

• Introduced passive elements

• Introduced general MATC function to prescribe
accumulation/ablation function

• Introduced general LUA function to prescribe
accumulation/ablation function
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USER DEFINED FUNCTION

In a follow-up session, by changing the previous setup we show:

• How to write, compile and include a self-written user defined
function

• How to introduce time changing variables
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User Defined Function

• Replace the MATC/Lua function with a user defined function (UDF)
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All UDF’s have the same header in
Elmer(/Ice)



User Defined Function
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User Defined Function
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User Defined Function

Compilation is done with:

$ elmerf90 accumulation.f90 –o accumulation.so

The body-force section changes to:
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Speedup MATC-LUA-UDF

==> MATC.log <==

SOLVER TOTAL TIME(CPU,REAL):      1027.24 1080.45

ELMER SOLVER FINISHED AT: 2020/10/31 23:42:46

==> LUA.log <==

SOLVER TOTAL TIME(CPU,REAL):       458.81 471.08

ELMER SOLVER FINISHED AT: 2020/10/31 23:34:12

==> UDF.log <==

SOLVER TOTAL TIME(CPU,REAL):       434.00 446.95

ELMER SOLVER FINISHED AT: 2020/11/01 00:01:21
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DON'T USE MATC in
performance critical
parts

Lua almost as fast as
compiled code



End of second session

What you should know on top of previous sessions:

• Replacing (usually slow) MATC function by a compiled Fortran
User Defined Function (UDF)
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EXERCISE
For those, who want to go continue …
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Exercise

§ If time permits, lets put all things together and make a
thermo-mechanically coupled prognostic run. What do we
need to add?
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Creating a mesh

This is additional information on how to create the simple mesh
for this run using Gmsh for people to try on their own

Be aware that in the previous example actually we chose a flat
mesh which we morphed to the shape of the bedrock, here we
are directly producing the bedrock shape in first instance
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The Mesh

§Using Gmsh

§ Simply launch by:

§ $ gmsh testglacier.geo &
§ Don’t use the existing one in the Solution-folder, since we want to

keep it as a backup, should this one fail
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The Mesh
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The Mesh

87



• Do that for any further points

Point(1) = {2500, 500, 0, backres};
Point(2) = {0, 0, 0, frontres};
Point(3) = {625, 50, 0, frontres};
Point(4) = {1250, 300, 0, backres};
Point(5) = {1600, 250, 0, backres};

The Mesh
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The Mesh

Press on every point from left to right to
highlight them ▪

Press e and the line should appear
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The Mesh

Klick on the line and it should be
highlighted
As suggested above, press e
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The Mesh

§Gmsh does journaling into the geo-file
§ it immediately writes out your entries
§ This means, that you can drive Gmsh also solely via script
§ It also means that you can make changes and reload

§ Before you load:
§ Tools→Options: go to tab Advanced
§ Under Text editor command: sensible-editor to emacs

§ You should do a File→Save Options As Default

§ Geometry→Edit file

91



The Mesh

• Add:

Layers{10};Recombine;

• Save the changes

• In Gmsh:
Geometry→Reload
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The Mesh

Zoom in. Klick on the surface to highlight the
dashed lines (zoom first with mouse wheel)

Following suggestions  from top, and press e
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The Mesh

1

2

3

4

§ You have to zoom (mouse wheel) in and out of the
model

§ and  translate (right mouse button)
§ Select boundary in the given order (highlights in red)

and press “e” every time
§ If you selected  the wrong boundary, use “u” to unselect94



The Mesh

§ Finally, mesh the geometry: Mesh→2D

§And save the mesh: Mesh→Save
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• The whole script looks like this and
can be run via terminal:

$ gmsh -2 testglacier.geo

The Mesh
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